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Understanding the Structural Role of Unreinforced Masonry 

(URM) Infill Walls with Concrete structures 

 
Reinforced concrete (RC) frames with unreinforced masonry (URM) infill walls are 

commonly used as the structural system for buildings in many seismically active regions 

around the world. Structural engineers recognize that many buildings of this type have 

performed poorly during earthquakes. URM infill walls used in many countries worldwide of 

either burnt clay bricks or cement concrete block masonry. These URM infill walls are 

generally treated as non-structural elements, because they are used mainly for architectural 

purposes, and structural engineers often ignore them during structural design. 

 

1. Global Behavior of URM 

During earthquakes, infill walls affect the response of the structure, and may either beneficial 

or detrimental effects. Infill walls contribute to the lateral force resisting capacity and damping 

of the structure up to a certain level of ground motion. Infill walls increase the initial stiffness 

and decrease the fundamental period of the structure, which might be beneficial or detrimental, 

depending on the frequency content of the ground motion. 

 

URM infill walls are prone to early brittle failure, and infill wall failures may lead to the 

formation of a weak story, which can cause the building to collapse. Infill walls interact with 

the surrounding frame in such a way that column shear failure is made more likely. In addition, 

an unequal spatial distribution of infill walls for functional reasons – for example, windows and 

open commercial spaces on the street frontage and full walls adjacent to neighboring buildings 

can create torsion that places additional demands on columns and may cause them to fail 

 

Because of the potentially dire consequences of ignoring the structural role of URM infill 

walls, proper consideration of infill walls is essential in any structural analysis of RC frame 

buildings with infill walls. This document provides engineers with guidance on how to model 

infill walls and include them in structural analyses. 

 

The URM walls function as structural elements, and they may have beneficial or detrimental 

effects. Infill walls contribute to the lateral force resisting capacity and damping of the structure 

up to a certain level of structural response. They increase the initial stiffness and decrease the 

initial period of the structure, which might be beneficial or detrimental depending on the 

frequency content of the experienced ground motion. URM infill walls are prone to early brittle 
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failure. Infill walls interacting with frames tend to alter the building’s overall strength and 

stiffness distribution. This may be despite the design intent of the engineer, because infill walls 

are typically considered as “non-structural” and therefore neglected in the frame design. Many 

buildings have a soft story created by commercial space (shops) or parking at the ground floor 

(Figure 1-a & 1-b) 

 

Even in buildings without open spaces at the ground floor, brittle infill wall failure may lead to 

the formation of a weak and soft story during ground shaking in buildings that would have 

otherwise not had one (Figure 1-c & 1-d). 

 

In addition, infill walls interact with the surrounding frame in such a way that column shear 

failure is made more likely (Figure 1-e). Infill walls can also induce torsion when some sides of 

the building have solid infill walls and the other sides have either infill walls with openings or 

no infill walls for architectural or usage purposes (Figure 1-f). 
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Figure 1. Masonry infill-related damage in recent earthquakes. 
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An Example of the Effects of Unreinforced Masonry Infill 

 
Before moving ahead, it is instructive to see how infill alters the behavior of a bare RC 

frame. Using pushover analysis, we compare here the differences in behavior between a bare 

frame and the same frame with infill walls in all the stories except the first, shown in Figure 2 

below. The effect of the infill is emulated by a single diagonal compression strut in each bay. 

 

Figure 2. Bare frame (left) and the same frame with infill in all stories except ground (right). 

 

The pushover curves are compared in Figure 3. The strength and stiffness of the infilled frame 

is significantly increased due to the presence of infill, but the displacement capacity 

decreases and a soft story develops, which is evident from the displacement profiles in Figure 

4. The deformation accumulates in the bottom story – the true behaviour during an earthquake 

when infill is considered in the analysis, rather than being distributed evenlyover all stories 

when the designer ignores the infill and incorrectly models the building as a bare frame. 

 

So, based on these results, infill walls can be beneficial as long as they are properly taken into 

consideration in the design process and the failure mechanism is controlled (i.e., no weak 
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story is allowed to occur). However, this example also shows that failing to consider infill 

walls during structural design can lead to deadly weak-story collapses. 

 
Figure 3. Pushover curve comparison for the bare and infilled frames. 

 

 
Figure 4. Displacement profile comparison for the bare and infilled frames. 
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Performance Based Analysis 

1. Guidelines & Standards  

The guidelines and standards mentioned in the introduction include modelling procedures, 

acceptance criteria and analysis procedures for pushover analysis. These documents define 

force-deformation criteria for potential locations of lumped inelastic behavior, designated as 

plastic hinges used in pushover analysis. As shown in Figure 5 below, five points labelled A, B, 

C, D, and E are used to define the force deformation behavior of the plastic hinge, and three 

points labelled IO (Immediate Occupancy), LS (Life Safety) and CP (Collapse Prevention) are 

used to define the acceptance criteria for the hinge. In these documents, if all the members meet 

the acceptance criteria for a particular performance level, such as Life Safety, then the entire 

structure is expected to achieve the Life Safety level of performance. The values assigned to 

each of these points vary depending on the type of member as well as many other parameters, 

such as the expected type of failure, the level of stresses with respect to the strength, or code 

compliance. 

 
Figure 5. Force-Deformation Relation for Plastic Hinge in Pushover Analysis. 

 

Both the ATC-40 and FEMA 356 documents present similar performance-based engineering 

methods that rely on nonlinear static analysis procedures for prediction of structural demands. 

While procedures in both documents involve generation of a “pushover” curve to predict the 

inelastic force-deformation behavior of the structure, they differ in the technique used to 

calculate the global inelastic displacement demand for a given ground motion. The FEMA 356 

document uses the Coefficient Method, whereby displacement demand is calculated by 

modifying elastic predictions of displacement demand. The ATC-40 Report details the 

Capacity-Spectrum Method, whereby modal displacement demand is determined from the 

intersection of a capacity curve, derived from the pushover curve, with a demand curve that 
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consists of the smoothed response spectrum representing the design ground motion, modified to 

account for hysteretic damping effects. 

 

2. Modeling Infill Walls as Struts  

The most common method of modeling infill walls is to use equivalent diagonal compression 

struts (Figure 6). 

 

 
Figure 6. Equivalent diagonal compression strut modeling of infill walls (reproduced from 

FEMA 356, a public Domain document). 

 

 

The axial stiffness of an equivalent strut can be calculated with Equation 2 according to Section 

7.5.2 of FEMA-356. 
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In these equations, Em and Efe are the elastic moduli of the infill and the frame material, 

respectively, tinf is the thickness of the infill wall, hcol and Icol are the height and moment of 

inertia of the section of the column of the surrounding frame, hinf is the height of the infill wall 

panel and Ldiag is the length of the diagonal strut. The strength of the compression strut is 

calculated with the following Equation: 

 
Ainf is the cross-sectional area of the infill wall, fsinf is the shear strength of masonry and θ is the 

angle of the diagonal strut with the horizontal. 

 

o Special Case of Retrofitted Masonry Wall 

As a special case, it is also possible to model an infill wall retrofitted with mesh reinforcement 

and concrete by using TWO diagonal struts, one of which is a compression member and the 

other is a tension member. In this case, stiffness is calculated with the following Equation and 

distributed equally to the struts. 
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Em, Ec and Efe are the elasticity moduli of the infill, concrete used for retrofit and the frame 

material, respectively. The other terms in the equation are defined as follows: tinf is the 

thickness of the infill wall, tc is the thickness of the concrete, θ is the angle of the diagonal strut 

with the horizontal, hcol and Icol are the height and moment of inertia of the section of the 

column of the surrounding frame, hinf is the height of the infill wall panel and Ldiag is the length 

of the diagonal strut. The strengths of compression and tension members are calculated with the 

following Equations. 

 
Ainf and Ac (in2) are the cross-sectional area of the infill wall and concrete, respectively, fsinf is 

the shear strength of masonry, fc is concrete strength (psi), and θ is the angle of the diagonal 

strut with the horizontal. As is the total cross-sectional area of horizontal mesh reinforcement 

with spacing s, fys is the strength of steel, and Linf is the wall length. 

 

NOTE: For masonry struts, use the actual masonry properties, if known, to calculate the 

equivalent strut capacity. If the actual properties are not known, use the low values in ASCE-

41. Parametric studies, where the analyst conducts a series of analyses that vary one property of 

interest, such as a material strength, while leaving the others fixed, are very useful in bounding 

the potential response when the masonry properties are not known.  
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Using lower masonry strengths is not necessarily conservative, because stronger infill panels 

can cause shear failures in the adjacent columns. 
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Pushover Analysis using Csi ETABS Software 

 
Pushover analysis is a very powerful feature offered only in the non-linear version of 

ETABS. In addition to performing pushover analyses for performance-based seismic design, 

this feature can be used to perform general static nonlinear analysis and the analysis of staged 

(incremental) construction. ETABS menus and documentation refer to pushover analysis as 

static nonlinear analysis. 

 

Performing any nonlinear analysis takes time and requires patience. Please read the 

following information carefully before performing pushover analysis. Make sure to pay 

special attention to the Important Considerations section later in this guide. The key points 

for conducting pushover analysis can be summarized as follows: 

 

1. Defining how nonlinearity is considered 

2. Determining analysis cases 

3. Defining loading 

4. Selecting the type of load control 

5. Analysis Results 

6. Procedure for conducting pushover analysis 

 

1. Defining how nonlinearity is considered 

Several types of nonlinear behavior can be considered in a pushover analysis: 

 

Material Nonlinearity at Discrete, User-Defined Hinges in Frame/Line Elements. 

Plastic hinges can be assigned at any number of locations along the length of any frame 

element, wherever yielding or other inelastic behavior is expected. Uncoupled moment, torsion, 

axial force and shear hinges are available. There is also a coupled P-M2-M3 hinge that 

considers the interaction of axial force and bending moments at the hinge location. More than 

one type of hinge can exist at the same location. For example, you might assign both an M3 

(moment) and a V2 (shear) hinge to the same end of a frame element. Default hinge properties 

are provided based on ATC-40 and FEMA-356 criteria. 

 

For reinforced concrete frame buildings, use coupled P-M hinges when modelling columns and 

uncoupled moment hinges for beams. Separate shear hinges are recommended. To reduce the 



Evaluating Existing Concrete Structures with Masonry Infill Walls by Nonlinear Static Analysis – S01-016 

 

 

                              

  12 

size and complexity of the model, a number of analysts check shear forces in each member 

against that member’s shear capacity rather than using shear hinges. 

 

NOTE: Define the hinges using the criteria in ASCE 41. The hinge properties should properly 

consider the likely as-built conditions, rather that only the design drawings or code 

provisions. Many buildings in various countries worldwide will have columns with poor 

confinement and inadequate ties. Model the hinges conservatively, assuming that the strength 

and deformation capacity are on the low end of the possible range. 

 

Material Nonlinearity in the Link Elements. 

The available nonlinear behavior includes gap (compression only), hook (tension only), 

uniaxial plasticity along any degree of freedom, and two types of base isolators (biaxial 

plasticity and biaxial friction/pendulum). The link damper property has no effect in a static 

nonlinear analysis. 

 

Geometric Nonlinearity in All Elements. 

You can choose between considering only P-delta effects or considering P-delta effects plus 

large displacements. Large displacement effects consider equilibrium in the deformed 

configuration and allow for large translations and rotations. However, the strains within each 

element are assumed to remain small. The P-Delta effects option (without large deformations) 

is recommended. 

 

Adding or Removing Elements. 

Members can be added or removed in a sequence of stages during each analysis case. 

 

2. Determining Analysis Cases 

Static nonlinear analysis can consist of any number of cases. Each static nonlinear case can 

have a different distribution of load on the structure. For example, a typical static nonlinear 

analysis might consist of three cases. The first would apply Gravity load to the structure, the 

second would apply one distribution of lateral load over the height of the structure, and the 

third would apply another distribution of lateral load over the height of the structure. 

A static nonlinear case may start from zero initial conditions, or it may start from the results at 

the end of a previous case. In the previous example, the gravity case would start from zero 

initial conditions, and each of the two lateral cases could start from the end of the gravity 

case. 
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Static nonlinear analysis cases are completely independent of all other analysis types in 

ETABS. In particular, any initial P-delta analysis performed for linear and dynamic analysis 

has no effect upon static nonlinear analysis cases. The only interaction is that linear mode 

shapes can be used for loading in static nonlinear cases. 

 

3. Defining loading 

The distribution of load applied on the structure for a given static nonlinear case is defined as a 

scaled combination of ONE or MORE of the following: 

o Any static load case. 

o A uniform acceleration acting in any of the three global directions. The force at 

each joint is proportional to the mass assigned to that joint (i.e., that calculated 

from the tributary area) and acts in the specified direction. 

o A modal load for any Eigen or Ritz mode. The force at each joint is proportional to 

the product of the modal displacement (eigenvector), and the mass tributary to that 

joint, and it acts in the direction of the modal displacement. 

 

The load combination for each static nonlinear case is incremental, meaning it acts in addition 

to the load already on the structure if starting from a previous static nonlinear case. 

 

➢ Floor slabs in reinforced concrete frame buildings are generally modelled as rigid 

diaphragms. The rigid diaphragm causes the joints connected to the same floor slab to 

displace the same amount horizontally.  

 

➢ You will need to consider diaphragm deformations, and model the diaphragms as 

flexible, in the following cases: 

 

➢ Concrete slab is thinner than 100 mm (4 inches);  

➢ Diaphragm has span to depth ratio of 4:1 or greater, where span is defined as the 

span between lines of lateral resistance; and 

➢ Diaphragm has large opening (30% or more of floor area is a good rule of thumb). 

4. Selecting the Type of Load Control 

ETABS has two distinctly different types of control available for applying the load. Each 

analysis case can use a different type of load control. The choice generally depends on the 

physical nature of the load and the behaviour expected from the structure: 
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Force Control. The full load combination is applied as specified. Force control should be used 

when the load is known (such as gravity load), and the structure is expected to be able to 

support the load in the elastic range. The analysis applies the full load value defined by the sum 

of all loads specified in the Load Pattern box (unless it fails to converge at a lower force value). 

This option is useful for applying gravity load to the structure. 

 

Displacement Control. A single Monitored Displacement component (or the Conjugate 

Displacement) in the structure is controlled. The magnitude of the load combination is 

increased or decreased as necessary until the control; displacement reaches a value that you 

specify. Displacement control should be used when specified drifts are sought (such as in 

seismic loading), where the magnitude of the applied load is not known in advance, or when the 

structure can be expected to lose strength or become unstable. 

 

➢ Use Conjugate Displ. for Control 

The conjugate displacement is a generalized displacement measure that is defined as the work 

conjugate of the applied Load Pattern. It is a weighted sum of all displacement degrees of 

freedom in the structure: each displacement component is multiplied by the load applied at that 

degree of freedom, and the results are summed. 

 

The conjugate displacement is usually the most sensitive measure of displacement in the 

structure under a given specified load. It is usually recommended that you use the conjugate 

displacement unless you can identify a displacement in the structure that monotonically 

increases during the analysis. 

 

When you use the conjugate displacement to control the analysis, the load increments are 

adjusted in an attempt to reach the specified monitored displacement. However, the analysis 

will usually only approximately satisfy the targeted displacement, particularly if the monitored 

displacement is in a different direction than the conjugate displacement. 

 

➢ Monitor 

The Monitored Displacement is a single displacement component at a single point that is 

monitored during a static nonlinear analysis. When plotting the pushover curve, the program 

always uses the monitored displacement for the horizontal axis. The monitored displacement is 

also used to determine when to terminate a displacement-controlled analysis. The analysis is 

terminated when the Monitored Displacement reaches the specified Displacement Magnitude 

(unless it fails to converge at a lower displacement value). 
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NOTE: For the most meaningful pushover curve, it is important that you choose a monitored 

displacement that is sensitive to the applied load pattern. For example, you should not 

typically monitor degree of freedom UX when the load is applied in direction UY. Likewise, 

you should not monitor joints that are close to the restraints. 

 

NOTE: The target Displacement Magnitude for the Monitored Displacement is given a 

default value by ETABS of 0.04 times the Z coordinate at the top of the structure. Note that if 

the base of the structure has a Z coordinate greater than zero, the default displacement may be 

quite large. You may change this value as necessary. Only the absolute value of the 

Displacement Magnitude is used: the direction of loading is determined by the specified load 

pattern. 

 

5. Analysis Results 

ETABS provides several types of OUTPUT that can be obtained from the static nonlinear 

analysis: 

 

1. Base Reaction versus Monitored Displacement can be plotted. 

 

2. Tabulated values of Base Reaction versus Monitored Displacement at each point along the 

pushover curve, along with tabulations of the number of hinges beyond certain control points 

on their hinge property force-displacement curve can be viewed on the screen, printed, or saved 

to a file. 

 

3. Base Reaction versus Monitored Displacement can be plotted in the ADRS format where the 

vertical axis is spectral acceleration and the horizontal axis is spectral displacement. The 

demand spectra can be superimposed on this plot. 

 

4. Tabulated values of the capacity spectrum (ADRS capacity and demand curves), the 

effective period and the effective damping can be viewed on the screen, printed, or saved to a 

file. 

 

5.The sequence of hinge formation and the color-coded state of each hinge can be viewed 

graphically, on a step-by-step basis, for each step of the static nonlinear case. 
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6. The member forces and stresses can be viewed graphically, on a step-by-step basis, for each 

step of the static nonlinear case. 

 

7. Member forces and hinge results for selected members can be written to a file in spreadsheet 

format for subsequent processing in a spreadsheet program. 

 

8. Member forces and hinge results for selected members can be written to a file in Access 

database format. 

 

➢ Check the status of the internal hinges 

Check the status of hinges to see if the structure can meet the demand or not. Based on the 

hinge states and the failure mechanisms, the need for retrofit and the type of retrofit can be 

determined. 

 

The color of hinges (Figure7) defines the status of hinges. This building needs a retrofit to 

prevent the soft story from forming. Once you have created a model, it is straightforward 

to modify it by adding new elements in different places to test out potential retrofit 

solutions. 

 
Figure 7. Hinge Status Color. 
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6. Procedure for Conducting Pushover Analysis 

The following general sequence of steps is involved in performing a static nonlinear analysis: 

 

1. Create a model just like you would for any other analysis. Note that material nonlinearity is 

restricted to frame and link elements, although other element types may be present in the 

model. 

 

2. Define the static load cases, if any, that are needed for use in the static nonlinear analysis 

(Define > Static Load Cases command). Define any other static and dynamic analysis cases that 

may be needed for steel or concrete design of frame elements. 

 

3. Define hinge properties, if any (Define > Frame Nonlinear Hinge Properties command). 

 

4. Assign hinge properties, if any, to frame/line elements (Assign > Frame/Line > Frame 

Nonlinear Hinges command). 

 

5. Define nonlinear link properties, if any (Define > Link Properties command). 

 

6. Assign link properties, if any, to frame/line elements (Assign > Frame/Line > Link 

Properties command). 

 

7. Run the basic linear and dynamic analyses (Analyze > Run command). 

 

8. Define the static nonlinear load cases (Define > Static Nonlinear/Pushover Cases command). 

 

9. Run the static nonlinear analysis (Analyze > Run Static Nonlinear Analysis command). 

 

10. Review the static nonlinear results (Display > Show Static Pushover Curve command), 

(Display > Show Deformed Shape command), (Display > Show Member Forces/Stress 

Diagram command), and (File > Print Tables > Analysis Output command). 

 

11. Perform any design checks that utilize static nonlinear cases. 

 

12. Revise the model as necessary and repeat 
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Conclusions  

 
1. Infill walls can be beneficial as long as they are properly taken into consideration in the 

design process and the failure mechanism is controlled (i.e., no weak story is 

allowed to occur) 

 

2. Nonlinear analysis takes time and patience. Each nonlinear problem is different. Expect 

to spend a certain amount of time to learn the best way to approach each new problem. 

Start simple and build up gradually. Make sure the model performs as expected under 

linear static loads and modal analysis. Rather than starting with hinges everywhere, add 

them gradually beginning with the areas where you expect the most nonlinearity. Start 

with hinge models that do not lose strength for primary members; modify the hinge 

models later or redesign the structure.  

 

3. Perform your initial analyses without geometric nonlinearity. Add P-delta effects, and 

possibly large deformations later. Start with modest target displacements and a limited 

number of steps. In the beginning, the goal should be to perform the analyses quickly so 

that you can gain experience with your model. As your confidence grows with a 

particular model, you can push it further and consider more extreme nonlinear behavior. 

 

4. Mathematically, pushover analysis does not always guarantee a unique solution. Inertial 

effects in dynamic analysis and in the real world limit the path a structure can follow. 

But this is not true for static analysis, particularly in unstable cases where strength is 

lost due to material or geometric nonlinearity.  

 

5. Small changes in properties or loading can cause large changes in nonlinear response. 

For this reason, it is extremely important that you consider different loading patterns, 

and that you perform sensitivity studies on the effect of varying the properties of the 

structure. At minimum, the recommended lateral load patterns include a uniform load 

distribution and a triangular load distribution representing the fundamental vibration 

mode. 
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